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How	to	change	black	to	another	color	in	photoshop

How	to	change	all	black	to	another	color	in	photoshop.	How	to	change	black	to	other	color	in	photoshop.	How	to	change	black	to	a	different	color	in	photoshop.

By	Roger	Smith	I	Line	4	Image	of	Chrisharyney	from	Fotolia.com	Adobe	Photoshop	is	a	tool	created	to	improve	and	edit	images	using	various	techniques.	Using	Adobe	Photoshop,	it's	very	easy	to	digitally	change	images	and	post-processing	to	create	the	desired	look	when	you	take,	or	seeing,	the	image.	The	program	was	released	for	the	first	time	in
1990	by	Adobe	Systems	and	is	the	market	leader	for	image	manipulation,	starting	from	2010.	There	are	many	techniques	within	Photoshop	to	realize	what	you	want	and	change	the	Line	color	can	be	relatively	simple	if	done	correctly.	Find	the	image	you	want	to	change	and	right-click	on	it.	Choose:	"Open	with>	Adobe	Photoshop."	This	can	also	be
realized	before	opening	photoshop,	choosing:	"File>	Open"	and	browsing	the	image.	Make	sure	the	image	is	in	RGB	color	mode	using	the	command:	"Image>	mode>	RGB	color."	Create	a	new	level	on	the	level	you	want	to	modify	and	fill	this	level	with	the	color	you	want	for	the	lines.	Find	the	Pulldown:	Leyer	Palette	Blending	and	select:	"Sleenten>
Screen>	Linear	Dodge."	The	image	should	take	the	previously	selected	color.	Once	you	reached	what	you	were	looking	for	using	a	level	or	more	layers	if	they	were	needed	more	colors,	flatten	the	image	below:	"Layer>	Flatten	image"	and	then	save.	By	Ryan	Menezes	The	Jupiterimages	/	Comstock	/	Getty	Images	Most	Photoshop	default	models	use
neutral	shades	of	gray	because	the	colors	of	the	model	usually	do	not	count.	When	applying	a	model	to	the	enlarged	image,	you	combine	the	colors	of	the	image	with	the	design	of	the	model	to	create	the	illusion	of	the	texture.	However,	you	can	place	a	template	on	other	layers	or	on	a	white	canvas,	viewing	the	color	of	the	model	in	your	finished
product.	To	change	this	color,	you	can	apply	a	colored	filter	to	an	existing	scheme.	Create	a	new	blank	file	in	Photoshop.	Right-click	the	clone	stamp	icon	in	the	toolbox	and	click	"Template	Template	Tool"	to	switch	to	the	template	stamp	tool.	Click	on	a	reason	from	the	drop-down	box	in	the	Options	toolbar.	Click	and	drag	on	the	canvas	to	completely
cover	it	with	the	model.	Click	"Picture",	"Adjustments"	and	"Photo	Filter"	to	open	the	Photo	Filter	dialog.	Click	"Color"	and	click	on	the	colored	square	next	to	it	to	open	the	Select	Filter	Color	dialog	box.	Choose	your	color	from	the	color	binder.	Type	"100"	in	the	density	text	box	and	click	"OK"	to	apply	the	color	to	the	model.	Click	"Edit"	and	"Define
the"	model	to	start	the	pattern	name	dialog.	Type	a	name	for	the	model,	then	do	On	"OK"	to	save	the	model	with	the	modified	color.	Skip	to	the	contents	Have	you	ever	wondered	what	you	look	if	your	eyes	were	a	different	color?	My	mine	are	gray,	but	I	always	thought	that	Brown	would	be	suitable.	Of	course,	you	could	go	and	buy	colored	contacts,
but	it's	much	easier	to	use	only,	PhotoshopÃ	¢	â,¬	"or	your	favorite	free	image	editor	like	Gimp	...	to	change	the	color	of	the	eyes.	I'm	going	to	show	the	Technique	Using	Photoshop	So,	if	you	are	using	a	different	app,	you	the	need	to	identify	the	most	appropriate	equivalent	instruments.	The	instructions	should	work	in	many	image	editing	programs.
Open	the	image	you	want	to	use	in	Photoshop.	This	is	the	image	I’m	working	with.	To	get	started,	create	a	new	blank	layer	with	Blend	mode	set	to	color...the	keyboard	shortcut	is	Control+Shift+N	for	PC	users,	Command+Shift+N	for	Mac	users.	Then,	in	the	“Mode”	drop-down	menu,	choose	“Color”.	Double-click	the	foreground	sample	and	set	it	to	a
wild	color	like	light	blue	in	the	image	below.	Go	to	Edit	>	Fill	and	select	Foreground	Color	to	fill	the	blank	layer	with	this	color...You	can	also	use	the	keyboard	shortcut	Alt+Backspace	(on	Windows)	or	Option+Delete	(on	Mac).	Everything	in	your	image	will	now	look	like	a	strange	shade	of	blue.	This	will	help	you	choose	your	eyes.	Add	a	black	layer
mask	to	the	color	layer	by	holding	down	Option	or	Alt	and	clicking	the	New	layer	mask	button.	Remember,	with	a	mask,	white	reveals	and	black	hides.	Enlarge	the	subjects'	eyes	(Control-+	on	Windows,	Command-+	on	Mac)	and	select	the	Brush	tool	by	pressing	B	on	the	keyboard.	Select	the	Soft	Round	bushing	from	the	Brush	menu,	set	Opacity	to
100%,	and	Flow	to	about	60%.	Reset	the	color	samples	to	their	default	values	of	black	and	white	by	pressing	the	D	key,	then	replace	them	to	have	white	as	the	foreground	color	by	pressing	X.	Select	the	layer	mask	and	start	painting	white	over	the	eyes.	This	will	show	the	color	level.	Be	careful	with	the	iris	and	avoid	the	pupil	until	you	have	a	good
mask.	Repeat	the	procedure	for	the	other	eye.	(You	may	need	to	change	the	size	of	the	brush	to	fit	certain	areas,	depending	on	the	photo.)	The	mask	probably	looks	a	little	painted,	so	go	to	Filter	>	Blur	>	Gaussian	Blur	and	add	about	2	pixels	of	blur	to	the	mask.	This	will	ease	the	transitions.	Now	that	you	have	a	good	mask	for	both	eyes,	it	is	time	to
color	them	in	a	more	natural	shade.	Select	the	color	level,	then	double-click	the	foreground	color	sample.	With	some	experiments,	I	found	that	the	following	values	are	a	good	starting	point	when	changing	someone’s	eye	color:	For	blue	eyes,	set	H	to	210,	S	to	7,	and	B	to	70.	For	grey	eyes,	set	H	to	210,	S	to	3	and	B	to	70.	For	green	eyes,	set	H	to	100,
S	to	4,	and	B	to	80.	For	brown	eyes,	set	H	to	40,	S	to	25	and	B	to	15.	Compose	the	color	you	want	to	use	and	press	OK.	Go	to	Edit	>	Fill	in	and	select	Foreground	Color	to	change	the	subject’s	eyes.	Depending	on	the	color	of	the	subject’s	eyes,	you	will	also	need	to	light	up	or	darken	the	iris	to	make	things	happen.	Rebecca,	the	model	in	the	photo	I'm
using,	has	dark	brown	eyes,	so	they	have	to	be	lit	a	little	bit.	For	my	lighter	gray	eyes,	I	often	have	to	darken	things.	Add	a	Curve	Adjustment	Level	to	the	image.	It	is	the	best	way	to	adjust	brightness	in	Photoshop.	You've	already	done	a	big	level	mask,	so	it	doesn't	make	sense.	I	mean.Again.	Hold	down	Option	or	Alt	and	drag	the	layer	mask	from	the
Color	layer	to	the	Curve	layer.	Now	the	curves	will	only	affect	the	eyes.	Select	a	point	on	the	curve	and	drag	upwards	to	illuminate	the	eyes	or	downwards	to	darken	them	if	necessary.	The	values	I	have	suggested	in	this	article	are	just	a	starting	point.	Each	image	is	unique.	While	most	of	the	time	the	colors	I	recommend	should	give	you	a	natural	eye
color,	if	they	don’t	seem	right,	touch	up	the	color	and	curvature	levels	until	they	do.	Changing	your	eye	color,	or	that	of	a	friend,	in	Photoshop	is	a	lot	of	fun.	Everyone	wants	to	know	what	they’d	look	like	with	blue	or	green	eyes.	You	don’t	have	to	limit	yourself	to	the	natural	color	of	the	eyes,	or	the	same	technique	can	be	used	to	make	the	eyes	yellow
like	wolves	or	the	eyes	purple	Targaryen.	Microsoft	PowerPoint	has	several	simple	color	adjustment	options	so	that	you	can	quickly	and	easily	style	the	images	in	PowerPoint	presentation.	Whether	you	want	to	create	an	artwork	or	just	match	your	document	to	your	printer	settings,	you	can	edit	your	black	and	white	images	in	PowerPoint	How	to	edit	a
black	and	white	image	in	Microsoft	PowerPoint	Changing	the	black	and	white	image	in	Microsoft	PowerPoint	is	easy!	The	color	adjustment	only	affects	the	image	in	the	document	(and	is	reversible);	it	has	no	effect	on	the	original	file.	First,	click	to	select	the	image	in	the	document.	Switch	to	the	“Format”	tab	on	the	multi-function	bar.	Click	the
“Color”	button	In	the	drop-down	menu	that	appears,	click	the	“0%	saturation”	option	in	the	“Color	saturation”	group.	Here	it	is!	Your	photo	is	now	in	black	and	white.	And	don’t	worry.	PowerPoint	still	has	the	original	image	with	all	its	built-in	colors,	so	you	can	easily	return	to	the	original	colors	(or	even	change	them	to	something	else).To	restore	the
current	black	and	white	image	to	its	original	state,	simply	tap	the	“Format”	tab	again	and	click	the	“Image	Reset”	button.Ã¬,	your	image	returns	to	the	original	color.	New	Image:	In	the	Photoshop	File	menu,	choose	New.	Select	a	color	from	the	drop-down	menu	in	Background	Content.	Selecting	existing	image:	Select	the	Magic	Wand	tool.	Hold	down
Shift	and	click	on	the	background	areas	you	want	to	replace.Existing	Image	Replace:	With	the	background	selected,	use	the	Fill	tool	to	apply	a	new	color	from	the	color	palette.	This	article	explains	how	to	change	the	background	color	in	Photoshop	2020	on	new	or	existing	image	files.	Includes	information	about	different	tools	to	make	a	selection	and
different	methods	to	apply	the	color	to	the	selected	background.	Changing	the	background	color	of	an	image	having	a	dramatic	effect	on	its	appearance,	and	one	of	the	best	tools	to	do	so	is	adobe	photoshop,	although	there	are	some	excellent	alternatives.	that	you	have	the	full	version	or	a	free	trial	version,	there	are	some	different	methods	that	you
can	oare	forIt's	so.	Change	the	background	in	Photoshop	Before	creating	a	new	image	is	the	fastest	way	to	set	your	preference.	When	making	a	new	document	in	Photoshop,	there	will	be	an	option	to	choose	the	background	color.	Use	your	drop-down	menu	or	color-select	box	to	choose	the	color	you	prefer	the	background	to	be.	When	creating	a	new
image,	you	will	have	your	choice	as	its	background	color.	In	Photoshop	CC	2018	and	more	recent	this	option	will	be	in	the	lower	right	corner	of	the	new	document	window.	In	the	oldest	versions	of	Photoshop,	it	is	located	at	the	bottom	of	the	window.	To	change	the	background	color	after	creating	the	image,	you	can	create	a	new	background	in	a	color
of	your	choice:	select	the	Layers	tab	at	the	top	of	the	window.	Select	New	Fill	Level,	then	select	Solid	Color	â	€	"unless	you	particularly	want	a	gradient	or	pattern	background.	Give	the	new	layer	a	name,	then	select	OK	when	prompted.	Select	a	color	from	the	palette	and	select	OK	again.	Before	you	can	change	the	background	color	in	Photoshop	you
need	to	select	it.	Here	are	some	ways	to	do	it,	if	you	are	working	on	Windows	or	MacOS:	the	Magic	Wand	tool	is	quick	and	dirty	and	works	better	when	there	are	stark	differences	between	the	first	floor	and	the	background,	but	it	can	work	pretty	well	if	you	are	short	in	time	or	patience.	To	do	this,	select	the	Magic	Wand	tool	from	the	menu	to	the	left
(it's	the	fourth	down	and	looks	like	a	wand).	Then	press	and	select	Shift	and	select	the	different	parts	of	the	background	you	want	to	change	the	color	of.	If	the	magic	wand	is	a	bit	too	heavy	or	not	faded	enough	to	select	all	your	background,	the	lapse	tool	can	be	useful.	There	are	three	that	you	can	exploit	for	the	same	purpose.	Select	and	hold	the
third	option	in	the	menu	on	the	left	to	be	given	a	choice.	The	standard	lapse	requires	hand	draw	the	background;	Polygonal	Lasso	will	allow	you	to	draw	defined	lines,	rectilinear;	Magnetic	Lasso	stands	at	the	existing	lines	and	edges.	When	you	have	finished	drawing	around	your	background,	or	connect	to	the	starting	point	to	finalize	it,	or	press	Ctrl
+	click.	If	you	use	a	Tablet	running	Windows	10,	pressing	and	holding	down	on	the	screen	you	will	give	you	the	opportunity	to	right-click,	which	opens	a	context	menu	with	additional	functions.	Select	the	one	you	need,	then	tap	for	the	same	function.	If	you	want	a	super	precise	way	to	select	the	background	of	an	image,	you	can	use	the	masking	tool.	It
is	the	second-hand	tool	in	the	left	menu.	Select,	then	use	a	similar	brush	or	tool	to	paint	the	selection.	This	can	be	combined	with	the	above	methods	to	perfect	an	existing	selection.	You	should	see	the	You	selected	appear	in	red.	When	you	are	satisfied	with	your	selection,	select	the	mask	tool	again	to	see	your	selection	in	dashed	lines.	If	the
background	is	much	larger	than	the	first	floor	when	you	make	a	selection	with	any	of	the	above	methods,	select	the	first	floor	instead,	then	then	CTRL	+	SHIFT	+	I	to	reverse	your	selection	and	highlight	the	background.	Now	that	you	have	selected	the	background,	it's	time	to	change	its	color.	You	can	do	it	in	a	couple	of	different	ways,	depending	on
the	color	you	want	the	background	to	be:	u	to	bring	the	Hue	and	Saturation	menu.	Use	the	hue	cursor	to	change	the	tonnality	of	your	background.	You	will	keep	the	same	lighting	levels	as	before,	but	the	global	color	palette	will	change.	If	you	prefer	to	have	a	more	uniform	color	in	the	background,	you	can	first	remove	it,	then	add	again	before
adjusting	the	tonnality.	To	do	this,	press	CTRL	+	SHIFT	+	U	to	transform	the	grayscale	image,	then	open	the	Hue	and	Saturation	menu	as	before.	Select	Colorize	to	add	the	color	back	to	the	background,	then	use	the	hue	cursor	to	adjust	its	color.	If	you	prefer	to	have	a	white	color	as	a	background,	you	can	simply	paint	over	what	you	already	have.	On
Windows	and	MacOS,	press	F7	to	open	the	layered	window.	Select	New	Layer	to	create	a	new	layer.	It	is	the	second	icon	on	the	right.	Select	Fill	the	tool	from	the	menu	to	the	left.	It	looks	like	a	paint	bucket	and	is	called	the	tool	paint	buckle	in	some	versions	of	Photoshop.	Use	the	color	palette	at	the	base	of	the	menu	on	the	left	to	select	the
background	color,	then	simply	select	within	the	selection	to	create	a	white	color.	If	you	prefer	a	gradient	effect	in	your	background,	select	and	hold	file	tool	to	give	you	the	gradient	bucket	option,	then	select	and	drag	within	the	selection	to	create	a	gradient	color	for	your	new	background.	Thank	you	for	letting	us	know!	Tell	us	because!	Because!
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